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_| STOP PRESS... Save on Roland VS Harddisc Packages
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—; Roland VS1680
-l Including 2.1 gig Hard drive and effects board
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16 track digital recorder with up to 256 virtual
tracks

=4
~3¢

24 bit internal recording

large 320 x 240 dot graphic backlit LCD for
easy editing

cut, copy and paste using non-destructive
editing with 999 undo levels

Balanced XLR inputs with phantom power
Auto mix stores fader levels and pan
Option to add 2n¢ effect board

Coaxial and optical I/0

L Sem A

Package price
VS1680

and VS-CDR

Interest Free credit deal

Deposit £319
And 24 monthly payments of fog
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Roland VS880
Including 2.1gig Hard drive and effects board

8 track digital recorder

with up to 64 virtual tracks

4 tracks simultaneous recording
Digital mixer with 3 band EQ

Cut, copy and paste using non-destructive
editing with multiple undo levels
Automation of levels from external midi

sequencer
8 locate points within one song

Package price
VS880 V2 expanded

and VS-CDR

Interest Free credit deal
Deposit

f169
And 18 monthly payments of £8g
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DGE ROAD, GUILDFORD.
TELEPHONE - 0870 602 0131

7 soendproo! demeo rooms.

By Who? The Music Industry Associaticn

Why? Because...
We stock over £1.5 million of guitars, keyboards, acouslics,
modules, synths, home recording and professional recording gear,
computer software, multifs, basses, drums, PA, plus 000% of
sccessories all under one reof.
We offer cut-throat discount prices on all the best selling brands.
We have a 7,000 sq. iL air conditloned showroom with

We have 20 fully trained and expedenced staff to give valuable,
unbiased advice as well as unbeatable aftersales care. (And they're
not paid on commission, 50 you wor get sold anything you dom
needf)
Our exclusive Gold Warmanty covers everything we sell, so even
when your gear lefs you down - we wor'l!
And if that's not encugh we also offer 0% finance, next day mall
order, part axchange, second hand gear, on site repairs, specialist
education sales division, plus much moch more.
Come and see us soon, just 5 minutes from jct 30 on the Mas or 35
minutes on the train from Waterioo. Allernatively give us a call, (we
have 8 telaphone Bnes 5o you'll always get Srough), and find out for
yoursell why Andertons Music Co has been voled “Best Music
Retaller, 3997".
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CAKEWALK RO AUDIO 7

JANET HARNIMAN COOK
goes great guns with

the latest version of
Twelve Tone’s popular
MIDI + Audio recording
software for PC owners.

212
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Ithough Cakewalk Pro Audio is regarded
in Europe as very much the junior member
of the big three of PC MIDI + Audio
sequencing packages, Cakewalk so
dominates the US market that it is claimed to be
the world’s best-selling sequencer. Whereas
Steinberg’s Cubase and Emagic’s Logic Audio
were originally developed for the Atari and
Macintosh platform and subsequently ported over
to the PC, Cakewalk is a native PC product dating
back to the early days of DOS.
Cakewalk has been consistently at the forefront

SOUND ON SOUND °* Sepiember 1998

of PC sequencer development and was the first PC
application to provide many of the advanced
sequencing features that we now take for granted,
such as support for multiple MIDI ports, multi-
channel audio cards, multi-track hard disk audio
using internal PC soundcards, on-board real-time
audio effects processing, and support for DirectX
audio plug-ins.

Cakewalk Pro Audio 7 provides many additional
features and represents a consolidation and
streamlining of the functions introduced in v6.
As most Cakewalk Pro Audio facilities remain



unchanged and previous versions have been
covered previously in SOS this review will focus
primarily on what is new in version 7.

The Cakewalk Pro Audio 7 package has been given
a makeover, with new logos and a distinctive blue
and orange packaging. Twelve Tone Systems are to
be commended for bucking the current trend
towards exclusively electronic documentation by
continuing to a provide a full printed manual.
The redesigned manual, which runs to about 400
pages, is clearly written, indexed, and task-oriented,
and contains a comprehensive explanation of the
Cakewalk Pro Audio 7 features and routines, plus
tutorials and tips on troubleshooting, and PC
system optimisation. It also contains a wealth of
background information that will make an expert of
any newcomers to MIDI + Audio recording.

The most obvious change that existing
users will notice is the vastly improved
Track View graphic interface which now
sports a snazzy 3D look and features ten
dockable tool bars with associated tool
tips. Toolbars can be placed anywhere in
the workspace with the exception of those
toolbars that contain time fields, such as
the new, simplified Transport bar or the
Tempo and Locator bars. These can only be
docked to the horizontal upper and lower
workspace perimeters. Especially useful is
the new Views toolbar that enables instant
access to the various editors.

A few menu items have been
reorganised and some commands are
relocated to other menus. For example,
the View menu has been simplified,
while CAL, Studioware and Playlist files
are now to be found in the File menu.
Audio housekeeping and export functions
have been transferred to the Tools menu
which also contains the new Global
Options dialogue where the default
settings for project file locations, MIDI
filters and the Drag and Drop options are
to be found.

Track selection routines have been changed
to bring them into line with conventional
Windows practice. Clicking on the track
number now selects the track and also
clears other existing selections; dlicking with
shift held down creates multiple selections;
clicking with control held down de-selects
individual tracks; and multiple selections
can also be made by dragging over several
track numbers. Additionally, mute and solo
selection routines are improved to enable
more than one track to have solo status,
and the selection bar now includes Mute

if you wanted to copy material between songs it
was necessary to import it using the File/Merge or
File/Extract commands. Now parts can be dragged
between projects using cut and paste routines,
in the same way as is possible between Cubase
arrangements. Each project has its own Undo
history and the Clock, Metronome and MIDI /O
information for each Project may be individually
defined.

The MIDI + Audio tracks contained in the
Cakewalk song project are displayed in the
new Console view. This represents the track
configuration elements in the user friendly form of
a virtual mixing console and many track definition
routines can now be carried out from the Console
view. All tracks have Name, Volume, Pan, Mute,
Solo, Record Arm and Record Source control
buttons. MIDI tracks additionally feature Channel,
Port, Bank and Voice Parameter definition, plus

~=ve3]
e

s 90900

Summer Pro Channel VC3
£199 including VAT

Pro Channel Summer Offer. Banana VC3s come with certificate of

authenticity, and a free promotional offer. Available while stocks last.

New Reduced Prices!

SC2 Stereo Compressor Now £1056 inc. VAT
(Was £1468 inc. VAT)

(Was £2349 inc. VAT)

SC3 Digital Stereo Compressor Now £1150. inc VAT

Please call us for more information and a free JOEMEEK Promotional Video.

and Solo indicators.

The new version now includes multiple
song file support — in previous versions,

Sound Valley Distribution Ltd.

The Briars, North Road, Amersham, Bucks, HP6 SNA
T. 01494 434738 F: 01494 727896 email: sales@soundvalley.demon.co.uk

SOUND ON SOUND ¢ September 1998
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CAKEWALK PRO AUDIO 7

“Cakewalk has
been consistently
at the forefront of

PC seqguencer
development and
was the first PC
application to
provide many of
the advanced
seqguencing
features that we
now take for
granted.”

PC REQUIREMENTS

233MMX processor, 64Mb RAM, 4Mb
video RAM, a fast hard drive and a 17"
monitor. A similarly featured Pentium Il
system should fly!

214

P Reverb and Chorus Sends. Audio tracks contain

auxiliary send controls, together with insert effects
and audio card output assignments.

The Console also includes audio master output
faders and ladder-style LED audio output meters.
The four audio auxiliary channels can be patched
to multiple DirectX-compatible effects plug-in
modules. The program ships with a much
improved suite of seven 32-bit, floating point,
stereo real-time effects processors (Reverb,
Chorus, Parametric EQ, Delay, Flanger, Pitch Shifter
and Time/Pitch Stretch) that feature extended
parameter control. The original mono CFX
modules are also included in updated versions.

Two varieties of mix automation are available:
Snapshot and Real-time recording. Snapshot
automation is the simpler of the two and consists
of inserting mix scenes (hence ‘snapshot’) at
designated points in time. Snapshots, which can
be saved, can be taken at any time during
recording or playback. Real-time recording mix
automation allows you to record an evolving
sequence of mix changes, in multiple passes if
required, and then edit them. This is performed
from the Piano Roll View Controllers panel which
is opened automatically by right clicking on the
Console fader or knob and selecting Edit
automation data. In practice, this method of
editing is both elegant and efficient.

TRACK ARMING

Cakewalk Pro Audio 7 includes track record
arming, which not only acts as a safety measure to
prevent the inadvertent overwriting of existing
material, but also enables recording to take place
simultaneously on multiple tracks. Track arming is
implemented by clicking on the R button in either
the Track or Console view, after which the Track
Arm indicator in the status bar illuminates. To
avoid unnecessary delays — for instance, during
the white heat of inspiration! — the current track
is automatically armed for recording if three
conditions are met:
s first, the record source must be set to

MIDI Omni;
* no other track is armed, and
* no other record source has been assigned.

AUDIO ENGINE

The audio mix engine has been revamped and
now provides 32-bit processing throughout the
effects chain bringing improved Windows NT
performance and greater processing efficiency
when using real-time effects. This means that
more effects can be used. Real-time master effects
can be applied to audio passing through the
master outputs.

Audio levels in general feature more responsive
linear scaling, making it possible to perform real-
time level changes more precisely. Curiously,
however, this appears to be accompanied by slightly
increased timing latency that is revealed when audio
tracks are muted during playback or recording. It
should be noted that audio levels of parts recorded
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in previous non-DirectShow v5.1 compatible
versions of Cakewalk Pro Audio may respond
incorrectly when played back in version 7, unless the
v6 compatibility option in Tools menu / Audio
Hardware is selected. It is now possible to position
mono parts across the stereo field, but to do so, the
Mono Record/Playback option in the Tools/Audio
Settings dialogue should be de-selected.

MISCELLANEOUS

There are many other small but useful changes to
be found. The Insert Measures command, absent
from v6 is restored; the threshold units in
Edit/Audio/Remove Silence and Edit/Audio/Extract
Timing are now expressed more usefully in decibels
rather than as percentages; holding the Zoom
button provides continuous zoom in or out (though
to my mind, while this is an improvement, it is a
poor substitute for PC keyboard zoom control).

The AWE 64 interface is improved and the
Wave Profiler now automatically checks the
accuracy of the soundcard audio out. The Auto
Shuttle anomaly that reset the playback loop to
the current Now position during pause has also
been corrected, and customised key binds are
now reflected in the menu items.

CONCLUSION

Cakewalk Pro Audio 7 addresses many of the
shortcomings of previous versions and includes
many excellent new features. There are still
important areas that need to be tackled — most
notably the lack of full-featured, multi-instrument
MIDI drum mapping and editing, the lack of audio
track offsets, and the absence of individual MIDI
channel activity indicators. That said, Cakewalk
Pro Audio goes from strength to strength with
each new version, and presents the user with an
easy-to-learn, powerful feature set that will satisfy
the sequencing needs of all but the most
demanding of users. Rock on Cakewalk!

(Many thanks to Riz Rizwan for additional

testing.) 04

3 Cakewalk Pro Audio 7 £299,
Cakewalk Pro Audio 7 Deluxe £369.
IX &t Cetera Distribution, Valley House,
2 Bradwood Court, St Crispin Way,
mmmm.u
KA +44°(0)1706 228039.
Il Tech Support Line.
+44 (0)1706 219999.
IR +44 011706 222989,
www.etcetera.co.uk
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128 MIDI channels
would have seemed like
complete overkill ten
years ago, but today’s
multitimbral voice
modules can use them
up at an alarming rate.
MARTIN RUSS checks
out an eight-port
patchbay/interface
from Opcode.

M pcode’s Studio 128X is the “twice-as-big”

2 (but in the same size box) elder sibling of
the Studio 64X MIDI Patchbay and Interface
WY that ! looked at in the May 1997 issue of
S0S, and has eight MIDI ports instead of the 64X’s
four. Having an extra four MIDI ports may not
seem all that significant, but it says a lot about the
user’s studio: four ports might be described as
‘compact’, but eight ports is definitely ‘serious’.
Welcome to the big league.

Each port on a multi-port MIDI interface/patchbay
can cope with 16 separate MIDI channels. An eight-
port version, therefore, can cope with 128 individual
MIDI channels or multitimbral parts — which
explains the Studio 128X's name. Whereas 128
channels would have seemed like complete overkill
ten years ago, today's multitimbral expanders can
take up alarming numbers of MIDI channels. Using
an eight-port interface and patchbay like the 128X,
however, should give you access to more than
enough sonic armoury to cope with all but the most
demanding of applications.

What a patchbay does is let you hook all of
that sound-producing power together in various
combinations, whilst the MIDI interface lets you
drive it all from a computer sequencer. You also get
straightforward sync’ing to timecode on tape. (For
more sophisticated synchronisation, the four-port
Studio 64XTC provides a much wider range of
additional sync features like ADAT and other digital
audio compatibility. Mike Collins reviewed the

64XTC in the April 1998 issue of SOS. Will we see
a similar 128XTC version in the future for anyone
who needs these extra sync functions?)

The Studio 128X allows you to route any MIDI input
port to any MIDI output port, with channel-changing
and filtering applied along the way. lt's possible to
merge two or more inputs together, or aftematively to
drive several outputs from one input. You can store
eight of your own routing programs inside, and three
utility programs are permanently stored inside, along
with five SMPTE striping programs. Editing of the
user programs can only be done with a Windows or
MacOS computer, but they can be used from the
128X alone once they have been stored in it.

When used with a sequencer, the Studio 128X
becomes a Computer-to-MIDI Interface. Cables
for serial data connection from the computer to
the Studio 128X are included, and there's a ‘thru’
connection so that you can still use the serial port (to
send to a printer, for instance) when you're not playing
with MIDI. On the PC, the 128X is bound by Windows
95's device limitation of 11 MIDI ports, which can
sometimes be exceeded by the combination of a
sound card and a multi-port interface (the 128X
actually uses nine MIDI ports, including the control
port, when connected to a computer). MacOS users
do not have the port limitation and can, if they
so desire, use two Studio 128Xs to give a full 256
(16 ports-worth) MIDI channels.

MacOS users also get the advantages of OMS-based
MIDI processing. In addition to the Routing,

OPCODE STUDIO 128X CROSSPLATFORM MIDI INTERFACE
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stacked, layered, transposed and split
assemblies of expander modules,
samplers, and the like. Once you'‘ve produced your
own customised MIDI equipment, then hooking it
together is much easier, and you have simple but
detailed control over exactly what is going on —
and it is all shown graphically!

The two main tests of how good patchbays
and interfaces are concern the time delay through
a MIDI patchbay, especially with heavy processing,
and the response to merging overload. The Studio
128X MIDI In to Out delay was about 500
microseconds, which went up to about two
milliseconds for Mac-based processing — more
or less the same as that of the 64X. Merge loading
worked okay for a typical ‘real world’ test in which
two sets of Notes and Pitch Bends were merged.
When | tried one of the more extreme System
Exclusive tests (two sets of Notes, Pitch Bend, MIDI
Clock and SysEx all merged) the target expander
module did exhibit some of the classic ‘MIDI
bandwidth exceeded/buffer overflow’ by-products
like notes not being turned off. However, this sort
of thing is less a real-world test than a test to
destruction!
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I could complain a little. | want to gripe about the
plug-top power supply’s flawed power connector,
which is located so close to the SMPTE jack sockets
that it makes simultaneous sync, rack-mounting and
power tricky to achieve for complex topological
reasons which are obvious when you see them, but
impossible to describe in words. Opcode haven't
fixed the lack of a front-panel program display, nor
the MIDUThru switches’ annoying lack of any sort of
easily visible indication — and these were both
mentioned in my review of the 64X! But | won't
press charges because...

The Studio 128X gets everything else just about
perfect. It looks cool, it has flashing LEDs for each in
and Out port, and the front panel operation is
wonderfully simple. The eight ports will suffice for all
but the biggest rigs, and the routing and filtering
capabilities will cover just about any eventuality —
and even if they don't, the Mac-based OMS processing
will! Physically it is small and neat, and the cost fits the
same descriptions. For anyone who wants to hook
together more than three bits of MIDI gear, the 128X

is well worth a very close examination. 409
Opcode Studio 128X £389 S
including VAT, -
I} 5CV London, 6-24 Southgate Road, Laxe
London N1 31J, UK. %
KR +44 (00171 923 1892. F [ °
n +44 (0)171 241 3644, o i

3 opcode@scvlondon.co.vk
K3 www.scvlondon.co.uk
K3 www.opcode.com
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 OPCODE STUDIO 128X £389

pros

-lpom 9 MIDI Quts.

* 8 user programs.

* Mac0$ and Windows compatible.
-to-use front panel.

cons
* No front panel indication of current ;

program. |
* Patches can only be edited via a computer.
« Black switches and a black front panel
can be tricky on a dark stage.
* The power connector topology.

summary |
Well suited to the larger home studio or |
project studio. A worthy successorto the
Studio 64. |
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) Digital | Mini | Analog
VS-340 Tape Disk Tape
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Digital X ; "
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Wavel
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VS-840 Digital Studio Workstation

It's no secret that the way ahead is digital recording. What may be
confusing is the variety of formats available.

Be confused no longer. Introducing the affordable VS-840, a

complete 64 virtual track digital recording studio and the first to record
directly 10 a built-in Zip drive.

For the producer in you, the V$-840's random access recording

system allows you to record a great verse and chorus and then simply

cut and paste tracks to try out endless song structures and arrangements
Throw in a built-in 12-channel mixer with 20-bit A/D converters,
a full-blown stereo multi-effects processor, 64 virtual tracks with
scrubbing ability. and you've got an unbeatable package at an
unbeatable price.

Head on over to your nearest Roland dealer and see the future of
digital recording. It's absolutely no contest.

Make it with a Roland



64 Virtual Tracks

You can record up to eight takes on each ef the V3-840's
eight tracks. Record your solo over and over on the same
track, keeping the previous takes. Bounce without fear. Comp
the ultimate track. A total of 64 virtual tracks are available.

The VS-840
for medeling the greatest vintaggs
s with digital Reverb,

=Roland

For details of this and other new Roland products call the Roland Brochure Hotline: 01792 515020
Roland (UK) Ltd. Atiantic Close. Swansea Enterprise Park, Swansea SA7 9FJ. UK web site: http//www.roland.co.uk
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ALL ABOUT DIGITAL AUDIO
PART 5: Following on from
last month’s look at digital
tape recording formats, HUGH ROBJOHNS
turns the spotlight on the techniques and

CD singles. However, these never really caught
on and it has subsequently proved cheaper to

technology of disk-based recording.

f you read last month'’s article, you will recall

that there are two fundamental approaches to

the design of tape-based systems: rotary

head and stationary head. There is a similar
dichotomy within disk-based systems, this time
between optical and magnetic formats. There is
also an increasingly significant third option which
represents a blend of the two.

OPTICAL DISCS

The most obvious digital disc format relying on
optical technology is the CD — something which
we all tend to take very much for granted fifteen
years after its launch. However, it is worth
revisiting the system as many of its concepts
enable understanding of the newer formats.
CDs are ‘pressed’ in much the same way as
vinyl records although the dimensions are
obviously smaller and the tolerances much finer.
The audio data is encoded along with timing and
various other pieces of information as either pits
or flats along a continuous spiral groove which
starts close to the centre of the disc and works
outwards at a fixed rate. The idea of starting on
the inside edge of the disc was to allow production
of discs with different diameters: the laser system
would always start at the same point, but continue
outwards until it found an ‘end-of-disc’ instruction.
In the early days, for example, we had three-inch

release singles on standard-sized discs.

Once the blank polycarbonate disc has been
stamped, the surface carrying the audio data is
coated with a microscopically thin layer of metal.
Usually, this is aluminium, although gold and silver
are also used. This is then protected from oxidisation
by 30pm-thick lacquer, which also carries the
screen-printed labelling. Although CDs are extremely
tough, damage to the lacquer layer usually means
the disc no longer plays properly, so never place
them label-side down. Ideally they should be put
back in the caddy, or, failing that, it is safer to place
them playing-side down. This might sound odd,
but because the laser is focused onto the aluminium
surface through 1.2mm of plastic, small scratches
and marks on the ‘playing’ surface become
insignificant (the laser beam is more than 1mm wide
on the disc surface, but focused to 1.7um on the
reflecting layer). It is the same concept as not
noticing the squashed bugs on the windscreen of
your car while your eyes are focused on the cars in
front. Small, troublesome scratches on the disc can
usually be polished out quite successfully with
toothpaste or the finest version of T-Cut car body
paint restorer. Be warned that it takes time and
patience. If it doesn’t work, don't blame me or SOS.

Reading data from a CD is a marvel of modern
technology and | am still impressed every time | think
about it. The pressed pits in the disc are seen as
raised bumps from the playing side and they are
arranged to be 0.125pm high — a quarter of the
wavelength of the 780nm infra-red laser light. To give



Dye recording layer

Polycarbonate substrate

you some idea of what that means, if the disc
was scaled up so that the bumps were 1cm
high, the disc would be around 10km across
(just over six miles)!

A monochromatic and coherent light
source is essential to ‘read’ the disc — the
light must be at one frequency and in the
same phase. The laser is focused to a spot
about twice as wide as the bumps and
therefore when one is encountered, light is
reflected from both the top of the bump
and the area around it. Since the bump is a
quarter wavelength high, the light reflected
from its top travels half a wavelength less
than the light reflected from the surrounding
surface, and is therefore out-of-phase with
it, resulting in cancellation. The pressing
tolerances mean that the bumps are unlikely
to be exactly a quarter-wavelength high,
but as long as they are close to that value,
partial cancellation will result. The photo-
detector in the optical pick-up simply has
to be able to recognise the difference
between lots of reflected light from the flat
areas and the dimmer light reflected when
a bump is present (see Figure 1).

Unlike vinyl records which rotate at a
constant speed (33 or 45rpm), the rotational
speed of a CD varies so that the laser
passes over the data at a constant rate of 1.4
metres/second (1.2m/S in the case of
80-minute-plus discs). This means a rotational
speed of 500rpm at the start of a disc, falling
to around 200rpm at the end. It has to work
this way because the size of the bumps is
related to the wavelength of the laser light
and cannot be changed. The mechanism for
controlling speed is very simple. As the data is
extracted from the disc, it is stored in a buffer
memory before being passed on at the correct
sampling rate to the decoding circuitry. If the
disc is spinning too fast the memory fills up: if
the disc is spinning too slowly the memory
empties. A simple feedback system based on
the memory capacity is used to control the
spin-motor servo. The precise rotational speed
of the disc is not important provided the data
comes off at an average of 44,100 samples
per second — hence the acceptability of linear
speeds between 1.2 and 1.4mVS.

Embodied within the data on the disc are
eight sub-code (auxiliary data) channels:
P,Q,R,S, T, U, Vand W. Of these, the most

important is the Q sub-code as this carries the
Table of Contents (TOC) at the start of the
disc which says how many tracks there are,
their timing information, running times, track
and index identification, and copy-prohibit
and pre-emphasis flags throughout the disc.
The P sub-code, which provides a very simple
means of locating the start of each track,
was originally intended for ‘dumb’ portable
players, but it is not particularly important
for most machines these days. The rest of
the sub-codes were unspecified in the Red
Book (see the CD Colours box) and hence
they are rarely used, although they have
found applications in remote projector
control for AV presentations, karaoke lyrics
and other still graphics (the CD+G format),
and computer data.

RECORDABLE CD

The CD-R is a WORM disc (write once, read
many). Once an area has been recorded, it
cannot be erased and re-recorded. There are
no editing facilities, although discs can be
recorded in stages with one or more tracks at
a time up to the Red Book CD limit of 99
tracks. The prices of CD-R recorders and their
blank media are similar to those of high-end
cassette machines (£500 for CD recorders
and less than £2 for a 74-minute blank), so
they are becoming increasingly common as
demo and master recorders in studios.

The construction of a CD-R disc is slightly
different to that of a standard CD, featuring
an additional layer in the disc construction. On
top of the polycarbonate substrate (which is
stamped with a ‘pre-groove’) a yellow/green
dye layer precedes the reflecting layer (usually
gold) before the standard lacquer and label
printing (Figure 2).

The principle behind the CD-R is that if a
high-powered laser (about 10 times stronger
than a normal CD player) is focused on the
dye layer, the green dye will absorb the red
light and get hot. At around 250°C the dye
deforms and shrinks to become much more
dense and the substrate swells to fill the
space, neither of which can be reversed.
When played in a conventional CD player,
the laser light is reflected from the gold
layer in the usual way, but where the dye
has deformed, less light is returned, thus
resembling the appearance of a bump on a
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Although it was originally designed to
carry audio data, other Industries were
quick to pick up on the CD format. We
now have a range of inter-related
formats, each identified by a different
‘colour’. The basic audio disc is defined
by the Red Book, with the Yellow Book
dictating the specifications for the
CD-ROM. This provides storage of either
computer data or audio and video data,
and has an extra degree of error
protection in place of the Interpolation
strategies of audio-only systems.

The Yellow Beok standard has been
enhanced with the XA extension
allowing audio and video data to be
Interposed with computer data on a
sector-by-sector basis. This Is the basis
of the Kodak PhotoCD standard as well
as the Green Book and White Book
standards. The Green Book relates to
Philip's proprietary CD-i format — a
home entertainment system which has
met with limited success. The same can
also be said of the full-motion video
format (using MPEG-1 data
compression) covered by the White
Book.

Writeable CDs {CD-Rs) are described
by the Orange Book. This allows
recordings to be made on a disc, either
all at once or on a piecemeal basis —
hence the term multi-session.

» conventional CD. The only snag is that because the

light has to pass through the dye layer twice (ie,
both on the way to the gold reflector and back
again), the overall reflectivity of CD-Rs is lower
than a normal CD and thus some older players are
not sufficiently sensitive to read CD-Rs reliably.

Since the dye inevitably varies from batch to
batch, CD recorders first perform what’s called
an optimum power check on each new disc to
find out just how much power is required to
deform the dye in the optimal way. When a new
blank disc is inserted, the machine’s display shows
'OPC’ (or something similar) while the machine
makes a series of test recordings with different
laser powers in a dedicated area near the centre
of the disc. The disc is then replayed to ascertain
the best setting and the result is stored for
reference in the Program Calibration Area (PCA) —
a ‘Regulo 6 for 20 minutes’ kind of thing!

Once the OPC is complete, the display shows the
available recording time, obtained from the data
encoded in the pre-groove of the disc. The pre-
groove is a wondrous thing, fulfilling several
functions in a very elegant manner. It is cut at a
precise pitch to define the spacing between
adjacent turns of the spiral (specified as 1.6um)
which is critical to the correct tracking of the laser
beam for both recording and replay. The pre-groove
also has a small “‘wobble’ from side to side as it
runs around the disc. When the disc is spinning
with a linear speed of 1.4m/S, the wobble causes
the tracking servos to oscillate at 22.05kHz (half the
sampling rate), thus enabling the machine to
maintain the correct linear disc speed throughout
the recording. The wobble is itself wobbled in such
a way that timing information can be encoded
(known as ATIP or Absolute Time in Pre-groove)
and this in turn allows the machine to know how
much recording time is left and where the laser is

Recording Area

information on a standard CD (Figure 3).

When a recording is made on a CD-R the audio
data is recorded directly to the main data area of
the disc, but the TOC information (track number,
duration and so forth) is stored in a temporary
area near the centre of the disc. This means that a
partially recorded CD-R cannot be played on a
conventional player as there is no recognisable
TOC from which it can ascertain the number of
tracks and where they start. However, a CD-R can
be made playable by going through a process
known as ‘Fixing Up’. This translates the temporary
table of contents into a Red Book-compatible
version which is recorded in the lead-in area before
the audio data section of the disc. The process
also writes an end-of-disc scroll after the final track.
The whole process can take several minutes and
once done, no further recordings can be made to
the disc. To a CD player, the CD-R now appears to
be perfectly normal, albeit with low reflectivity.

The specifications for the CD-R, laid down in the
Orange Book, permit the use of Skip IDs which allow
unwanted tracks on the disc to be passed over during
replay. However, conventional Red Book players do
not recognise skip instructions, so this facility is of very
limited use. If you make a mistake when recording a
CD-R, | would advise ejecting the disc, adding it to
your beer mat collection, and starti<ns1:XMLFault xmlns:ns1="http://cxf.apache.org/bindings/xformat"><ns1:faultstring xmlns:ns1="http://cxf.apache.org/bindings/xformat">java.lang.OutOfMemoryError: Java heap space</ns1:faultstring></ns1:XMLFault>